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Copyright
Drag and Drop Desktop Version 3.11 for Microsoft Windows NT. 

Build 134, May 1994, Intel Processors.

Copyright (c) 1993-1994 Thomas A. Reed, All Rights Reserved.



What is Drag and Drop Desktop ?
Drag and Drop Desktop is a fast an efficient Windows shell: it provides a simple and intuitive object 
oriented user interface that makes Windows faster and easier to use.

It enhances your desktop by allowing you to drag objects directly on and off the desktop window. 

Launch applications easily by pointing and clicking, or by dropping a document, on an application object.

Cleanup your desktop: get rid of those Program Manager overlapping windows and the pain of managing 
them. Drag and Drop Desktop puts application and document objects directly on the desktop where it's 
natural to have them.

Features
· Provides complete drag and drop client and server functions.

· Quickly launch applications just by double-clicking, or by dropping documents, on application 
objects.

· Maintains up to 16 separate desktop windows per user. 

· Enhanced Run command, with command history.

· Operates as the Windows NT shell or as a stand alone utility.

· Completely emulates Program Manager DDE interface. Setup programs operate normally with 
Drag and Drop Desktop.

· Support for multiple users providing private and shared desktops.

· Support for NTFS long file names. UNC file name support allows use of objects on networked 
computers.

· Provided with a setup program for simple installation, update, and removal of the software.

· Distributed as completely functional shareware with only one reminder to register upon exit.



Registration
Thank You for trying Drag and Drop Desktop. 

This program is shareware and distributed in an unregistered form. You may use and copy the 
unregistered version of this program freely.

If you find this program useful and would like to remove the registration reminder message, please 
register your own copy.    

Please DO NOT copy registered versions for other users.

You may register the software for $ 20 by mail or CompuServe. Registration gets you a serial number and
authorization key code to enable you to unlock and encrypt the program with your name. 

Registered users also benefit from the following;

· Automatic notification of future updates.

· No charge to register all future versions of the program.

· No charge to register Drag and Drop Desktop for Windows, or Windows NT for the DEC Alpha 
and MIPS computers (subject to availability).

· Unlimited software support via E-Mail or US Mail.

To register by mail:
Send a note with your name, address, E-Mail address, and phone number to the address shown below. 
Enclose a check or money order for $ 20. If you supply an E-Mail address, your serial number and key 
code will be promptly sent to you via E-Mail, otherwise US mail will be used.

Reed Consulting

2312 Belvedere

Toledo, Ohio 43614

To register on CompuServe:
Login to CompuServe in the usual way and type GO SWREG at the CompuServe prompt. Select register 
software from the menu and specify registration ID 2374. Your serial number and key code will be 
promptly sent to you via CompuServe E-Mail.



Software Support
Installation support is provided to all users at the addresses shown below. Product support is limited to 
registered users only.

CompuServe: 76237,516 

Internet: 76237.516@compuserve.com



What You Will Need
Drag and Drop Desktop is a fast and efficient shell program, any computer running Windows NT should 
be able to run this program without any problem. Specifically, the following hardware and software are 
required;

· An IBM compatible personal computer with one or more Intel 80386, 80486, or Pentium 
microprocessors.

· At least 250KB of free disk space on the drive containing Windows NT.

· A Windows compatible mouse or other pointing device.

· Microsoft Windows NT, version 3.10 or later.

Other versions of Drag and Drop Desktop are available for Windows, and Windows NT for the DEC Alpha
and MIPS computers.



Installation
Drag and Drop Desktop is provided with a setup program that is used to install, update and remove the 
software from your computer. 

After the welcome message, the setup program will present you with the opportunity to register the 
software using a serial number and authorization key code. If you have not registered your copy, simply 
select Skip and installation will proceed normally. To register the software in the future, just run setup 
again.

The setup program will prompt you to install as the Windows NT shell or as a separate utility program. It is
recommended that you install Drag and Drop Desktop as the shell, replacing the Windows Program 
Manager. You may change this mode of operation at any time in the future by running the setup program 
again and selecting a different option.

Note: You must be logged on with administrative privileges to install as the Windows NT shell.

To Install Drag and Drop Desktop:
1. Insert the program diskette in the floppy drive of your computer, normally drive A or drive B.

2. Select Run from the File menu of the Windows Program Manager.

3. Type A:SETUP.EXE for the command line, substitute B for A if the program diskette in drive B.

4. Follow the instructions presented by the setup program to complete the installation. If the setup 
program reports any errors or "Installation Failure" refer to the section Software Support for 
assistance.



Updating the Software
Once Drag and Drop Desktop is installed on your computer, you can use the setup program to update the
installation. Updating the software allows you to register or change any of the original installation options 
while preserving all of your desktops and objects.

Note: You must be logged on with administrative privileges to update the software if installed as the 
Windows NT shell.

To Update Drag and Drop Desktop:
1. Insert the program diskette in the floppy drive of your computer, normally drive A or drive B.

2. Select Run from the File menu of the Windows Program Manager.

3. Type A:SETUP.EXE for the command line, substitute B for A if the program diskette in drive B.

4. Click the Update button on the first setup dialog box.

5. Follow the instructions presented by the setup program to complete the update. If the setup 
program reports any errors or "Update Failure" refer to the section Software Support for 
assistance.



Removing the Software
If you decide not to use Drag and Drop Desktop, you can use the setup program to completely remove 
the software and all files it has created, leaving your computer as it was before installation. 

Note: You must be logged on with administrative privileges to remove the software if installed as the 
Windows NT shell.

To Remove Drag and Drop Desktop:
1. Insert the program diskette in the floppy drive of your computer, normally drive A or drive B.

2. Select Run from the Drag and Drop Desktop main menu, or File menu of the Windows Program 
Manager.

3. Type A:SETUP.EXE for the command line, substitute B for A if the program diskette in drive B.

4. Click the Remove button on the first dialog box.

5. Follow the instructions presented by the setup program to complete removing the software. 

Note: The first time a user operates Drag and Drop Desktop, an entry is made in the Windows NT registry
for that user. Because of restrictions imposed by the Windows NT security system, the setup program can
only remove registry entries for the currently logged-on user. 

A work around is to logon with the other user IDs that have executed Drag and Drop Desktop and run the 
setup program again. Specify /CLEAN on the command line, this option causes setup to delete all of the 
appropriate entries in the registry for the currently logged on user.



Use the Menu
The main menu is used to access most all of the functions in Drag and Drop Desktop. 

Unlike many Windows programs, the main menu is normally hidden from the user, and is only activated 
when needed to carry out a command.

To access the Main Menu:
· Place the mouse cursor on the desktop window and click the left mouse button.

- or -
· Press the F2 key.    



Create Objects on the Desktop
Drag and Drop Desktop Objects are program or document files that are represented by an icon and title 
on the desktop window. Any file on your computer can be an object on the desktop.

Once an object is created on the desktop it can be easily moved, copied, executed, and dropped on any 
other Windows application that supports drag and drop.

There are several ways to create new objects on the desktop: 
· Drag one or more files from the Windows File Manager on to the desktop window.

· Select the New command from the Object Menu. Complete the information in the dialog box, and 
click on OK. See New Object for more information.

· Select Import from the Edit menu. See Edit Import Files and Edit Import Group for more 
information.



Start Applications
It is easy to start applications using Drag and Drop Desktop, choose one of the following methods;

· Put the cursor over the object to activate and double-click the left mouse button.

· Select the object with the arrow keys or mouse, and press the ENTER key.

· Select Open from the Object menu. See Open Object for more information.

· Use the run command from the Main menu. See Run for more information.

· Drag a document file from the desktop or from File Manager and drop it on an object on the 
desktop.



Use Multiple Desktops
The idea of using multiple desktops came from the observation that most people use several different 
applications often when working on a project or routine task, and that the applications are different for 
different projects or tasks.

Drag and Drop Desktop provides up to 16 separate desktop windows per user. By creating a separate 
desktop for each project or task, you can keep your desktop organized with only the applications and 
documents needed for the particular project.

This design allows you to operate Windows more naturally, organizing documents and applications as you
would like. This is different from the Windows Program Manager that tends to be application oriented, 
organized by software vendor.

Some examples of typical desktops are; Personal Finance, Sales Proposals, Network Maintenance, 
Software Development, Games, Administration.

Related Topics;
Selecting a Desktop

New Desktop

Delete Desktop

Desktop Properties

Move Object

Copy Object



Use Common and Private Desktops
Drag and Drop Desktop provides a method for multiple users to share objects, and for users to keep 
objects private. This is done using common and private desktops. 

Common desktops are loaded by all users upon login or startup, then the users private desktops are 
loaded. The desktop type is changed using the Desktop Properties command.

If the current user is a member of the Administrators or Power Users groups, the user can create, delete, 
and edit common desktops. 

Regular users only use the objects on common desktops, any changes made are temporary and do not 
effect other users.

Objects are shared between users by moving or copying them between private and common desktops.

Related Topics;
Use Multiple Desktops

Desktop Properties

Move Object

Copy Object



Commands
About
New Object
Open Object
Move Object
Copy Object
Delete Object
Object Properties
New Desktop
Delete Desktop
Desktop Properties
Selecting a Desktop
Edit Arrange
Edit Clear
Edit Undo
Edit Save
Edit Import Files
Edit Import Group
Run
Logoff/Exit



About
The about command displays a dialog box with information on the version of Drag and Drop Desktop, 
who the program is licensed to, the serial number, the version of Windows NT, and information on the 
state of the Windows NT memory manager. 

Physical Memory is the total amount of RAM installed on the computer.
Virtual Memory is the total amount memory that is currently available to processes on this computer. It is 
determined by adding the amount of total physical memory and the current maximum size of the paging 
file. 
Memory Load specifies a number between 0 and 100 that gives a general idea of current memory 
utilization, in which 0 indicates no memory use and 100 indicates full memory use.



New Object
The new object command is used to create a new object on the desktop. Enter the information for the 
object in the dialog box as described below.

Title
The title is used to identify the desktop object. Any combination of up to 255 characters can be used. 
File Name
The file name is used to relate the desktop object to a program or document file. The file name can 
optionally contain a drive and path specification, up to a total of 260 characters in length. 
The file name must conform to MS-DOS file naming conventions if used on a FAT (MS-DOS) partition. 
Windows NT long file names are supported on NTFS partitions. If the file name contains spaces, it must 
be enclosed in double quotation marks.
Icon File Name
All objects are represented on the desktop with icons. The icon file name determines which file contains 
the icon to use. Objects can use the icons in any executable (EXE), icon (ICO), or dynamic link library 
(DLL) file. 
If the specified file does not contain any icons, a default icon will be used based on the object file type.
The file name must conform to MS-DOS file naming conventions if used on a FAT (MS-DOS) partition. 
Windows NT long file names are supported on NTFS partitions. If the file name contains spaces, it must 
be enclosed in double quotation marks.
Icon
The icon list box is filled with all of the icons in the file specified by the icon file name. To change the 
selected icon, click on the icon in the list box.

Directory
If a directory name is specified, the program will be executed from the specified directory when the object 
is opened. The directory name can be up to 260 characters.

The directory name must conform to MS-DOS file naming conventions if used on a FAT (MS-DOS) 
partition. Windows NT long file names are supported on NTFS partitions. If the directory name contains 
spaces, it must be enclosed in double quotation marks.

Run
The run buttons are used to select the initial size and location of the program window when this object is 
opened.



Accept dropped objects
The accept dropped objects check box is used to indicate if this program can accept other objects 
dropped on it. Any application that accepts the name of a file to open on the command line can accept 
dropped objects.



Open Object
The open object command is used to execute the program specified by the object file name. If the file 
name specifies a document file, the program that is associated with the document is executed.

The Windows File Manager is used to associate document files with applications.

The open object command can be executed from the main menu, by double clicking on the object, or by 
pressing the ENTER key.



Move Object
The move object command is used to move the selected object to another desktop. 

To move the object on the current desktop, simply drag the object using the mouse to the desired 
location.

Select the desktop to move the object to from the list box and click the OK button, or press the ENTER 
key.



Copy Object
The copy object command is used to copy the selected object to another desktop. 

To copy the object on the current desktop, press and hold the CTRL key and then drag the new object to 
the desired location.

Select the desktop to copy the object to from the list box and click the OK button, or press the ENTER 
key.



Delete Object
The delete object command is used to remove the selected object from the desktop. 

You may use the Undo command to restore any objects that were deleted since login or executing the 
Edit Save command.



Object Properties
The object properties command is used to change the appearance and function of the selected object on 
the desktop. 

Title
The title is used to identify the desktop object. Any combination of up to 255 characters can be used. 
File Name
The file name is used to relate the desktop object to a program or document file. The file name can 
optionally contain a drive and path specification, up to a total of 260 characters in length. 
The file name must conform to MS-DOS file naming conventions if used on a FAT (MS-DOS) partition. 
Windows NT long file names are supported on NTFS partitions. If the file name contains spaces, it must 
be enclosed in double quotation marks.
Icon File Name
All objects are represented on the desktop with icons. The icon file name determines which file contains 
the icon to use. Objects can use the icons in any executable (EXE), icon (ICO), or dynamic link library 
(DLL) file. 
If the specified file does not contain any icons, a default icon will be used based on the object file type.
The file name must conform to MS-DOS file naming conventions if used on a FAT (MS-DOS) partition. 
Windows NT long file names are supported on NTFS partitions. If the file name contains spaces, it must 
be enclosed in double quotation marks.
Icon
The icon list box is filled with all of the icons in the file specified by the icon file name. To change the 
selected icon, click on the icon in the list box.
Directory
If a directory name is specified, the program will be executed from the specified directory when the object 
is opened. The directory name can be up to 260 characters.

The directory name must conform to MS-DOS file naming conventions if used on a FAT (MS-DOS) 
partition. Windows NT long file names are supported on NTFS partitions. If the directory name contains 
spaces, it must be enclosed in double quotation marks.

Run
The run buttons are used to select the initial size and location of the program window when this object is 
opened.



Accept dropped objects
The accept dropped objects check box is used to indicate if this program can accept other objects 
dropped on it. Any application that accepts the name of a file to open on the command line can accept 
dropped objects.



New Desktop
The new desktop command is used to add a new desktop to the present list of desktops. Drag and Drop 
Desktop supports up to 16 desktops per user.    

Upon selecting the new desktop command, the following dialog box will be displayed;

Title
The title is used to identify the desktop. Any combination of up to 30 characters. If the Show Desktop Title 
option is selected, the title is displayed with the computer and user name, at the top of the desktop 
window.
Type
Specifies the type of desktop. Common desktops are visible to all users on this computer, while Private 
desktops are private to each user.
Note: You must be a member of either the Administrators or Power Users groups to be able to change or 
select the desktop type.
Wallpaper File
The wallpaper file specifies the bitmap file to be used as the background for this desktop. All bitmap files 
must be in the Windows directory to be used with Drag and Drop Desktop.
Wallpaper Type
Select the Center type to display the bitmap in the center of the desktop window. Select the Tile type to 
tile the desktop window with the bitmap image.
Object Snap
Select Object Snap and Grid Size. If Object Snap is enabled, all objects on the desktop are aligned on the
specified grid size.

Note: The automatic placement of objects and the horizontal size of the object title are controlled by the 
Windows icon spacing value. The icon spacing was adjusted to an optimum value for your display 
resolution the first time you executed Drag and Drop Desktop. You can change this value using the 
Control Panel desktop settings.



Delete Desktop
The delete desktop command is used to remove the active desktop and all objects on it. You will be 
prompted to confirm before deleting the desktop.

 
Note: You can not undo this command, be careful.



Desktop Properties
The desktop properties command is used to change the title, type and the background wall paper of the 
active desktop. 

Title
The title is used to identify the desktop. Any combination of up to 30 characters. If the Show Desktop Title 
option is selected, the title is displayed with the computer and user name, at the top of the desktop 
window.
Type
Specifies the type of desktop. Common desktops are visible to all users on this computer, while Private 
desktops are private to each user.
Note: You must be a member of either the Administrators or Power Users groups to be able to change or 
select the desktop type.
Wallpaper File
The wallpaper file specifies the bitmap file to be used as the background for this desktop. All bitmap files 
must be in the Windows directory to be used with Drag and Drop Desktop.
Wallpaper Type
Select the Center type to display the bitmap in the center of the desktop window. Select the Tile type to 
tile the desktop window with the bitmap image.
Object Snap
Select Object Snap and Grid Size. If Object Snap is enabled, all objects on the desktop are aligned on the
specified grid size.
Note: The automatic placement of objects and the horizontal size of the object title are controlled by the 
Windows icon spacing value. The icon spacing was adjusted to an optimum value for your display 
resolution the first time you executed Drag and Drop Desktop. You can change this value using the 
Control Panel desktop settings.



Selecting a Desktop
Drag and Drop Desktop maintains up to 16 separate desktops per user. Any desktop can be quickly 
selected from the menu or by using one of the following keys;

Key Normal Shifted
TAB Next Desktop with 

rollover to first desktop
Previous Desktop with 
rollover to last desktop

HOME Main Desktop

END Last Desktop

PgUp Next Desktop

PgDn Previous Desktop

Edit Arrange
The arrange command is used to order all of the objects on the active desktop. Objects are ordered in the
order they were created in, and placed horizontally and vertically along the top and right of the desktop 
window.

You may use the Undo command to restore the desktop prior to logging out, exiting, or executing the Edit 
Save command.

Note: The automatic placement of objects and the horizontal size of the object title are controlled by the 
Windows icon spacing value. The icon spacing was adjusted to an optimum value for your display 
resolution the first time you executed Drag and Drop Desktop. You can change this value using the 
Control Panel desktop settings.



Edit Clear
The clear command is used to delete all of the objects on the active desktop.    

You may use the Undo command to restore the desktop prior to logging out, exiting, or executing the Edit 
Save command.



Edit Undo
The undo command is used to remove all changes made to the active desktop since login, startup, or 
executing the Edit Save command. 

Once you logout or exit, all changes are saved to disk and can not be undone in the future.



Edit Save
The Save command is used to save the current state and contents of the active desktop. 



Edit Import Files
The import files command is used to create one or more objects on the desktop from a selected directory 
of files. Typically this command will be used to create many objects at once, with minimum effort. To 
create a few file objects, simply drag the files from the Windows File Manager on to the desktop.

The Edit Undo command can be used to undo this action.

Directory
Select the directory of the files to import by clicking the selection in the list box. Double-click on a drive or 
directory selection to change the current directory.
Files
The files specification is used to select the names of the files to be imported. This specification can 
contain wild card characters.
Once the directory and files have been selected, click the OK button. The following dialog box will be 
displayed, showing the file name and icon;

Click the Yes button to import the file shown. 

Click the No button to skip this file. 

Click the Yes to All button to import the file shown and all other files matching the specification. 

Click the Cancel button to cancel the import, all objects imported so far will be saved.



Edit Import Group
The import group command is used to import items from the Windows Program Manager on to the current
desktop. Select the name of the group that you wish to import from the listbox and click the OK button.

The Edit Undo command can be used to undo this action.



Run
You can use the Run command to start an application that you have not yet added to the desktop. 

Drag and Drop Desktop maintains a list of the last 32 applications that you have executed for quick 
access. 

To start an application by using the Run command
1. From the main menu, choose Run. 

2. In the Command Line box, type the path and name, including the extension, of the program file. If
you have already run this application before, you can select it from the command line list box. 

3. Select the Run Minimized check box if you want the application to be reduced to an icon when it 
starts. Select the Run Maximized check box if you want the application to use the entire display 
when it starts. 

4. Click the OK button.



Logoff/Exit
The Logoff    or Exit command is used to logout of Windows NT, or quit Drag and Drop Desktop. 

If installed as the Windows shell, the following dialog box is displayed to confirm ending your Windows 
session;

If your user profile allows you to shutdown the computer, the shutdown option will be displayed as shown 
above. 



Drag and Drop
The Microsoft Windows File and Program Managers use drag-drop functions to allow you to drag files 
from file manager to a group window of the program manager. 

The Program Manager is a client only, it accepts files from other applications, but will not allow items to be
dragged from it.

The File Manager is a server only, it allows you to drag files from it to other applications, but it will only 
accept files from itself.

Version 3.1 of Microsoft Windows documented the functions to implement the client side of the drag-drop 
operation. Drag-drop is supported on all Windows platforms including Windows NT. 

Many programs now accept dropped objects. To date, the server side of drag-drop operations remains 
undocumented, although now implemented by a number of programs including this one.

Drag and Drop Desktop is both a client and server. You can drag objects off the desktop and drop them 
on the Program Manager, and you can drag files out of the File Manager and drop them on the desktop.

Drag and Drop Desktop will work with any Windows or Windows NT program that supports the drag-drop 
protocol. Also, any program that will accept the name of a file on the command line can be used as a 
drag-drop client, even if it does not normally support drag-drop functions. See Object Properties for more 
information.



Keyboard Commands
Key Normal Shifted
F1 Help Help

F2 Main Menu Main Menu

F3 New Object New Desktop

F4 Delete Object Delete Desktop

F5 Run Run

F6 Object Properties Desktop Properties

F7 Move Object

F8 Copy Object

F9 Screen Saver Screen Saver

ENTER Open Object

INS New Object

DEL Delete Object

TAB Next Desktop with 
rollover to first desktop

Previous Desktop with 
rollover to last desktop

HOME Main Desktop

END Last Desktop

PgUp Next Desktop

PgDn Previous Desktop

DDE Interface
Drag and Drop Desktop contains a Windows NT Program Manager compatible Dynamic Data Exchange 
(DDE) interface.

Most all application setup programs use Program Manager DDE to create a program group and add 
applications to it.

When a setup program issues a create group command, Drag and Drop Desktop creates a new desktop 
for the application. Use the Copy Object or Move Object    command to copy or move the application 
objects to other desktops.

If Drag and Drop Desktop is operating as the Windows NT shell, it will completely emulate all DDE 
functions of the Program Manager, responding to application and topic of "PROGMAN".

If operating as a utility program, the DDE interface is active, but responds to "DESKTOP" application and 
topic. This prevents some setup programs from becoming confused when two Program Managers appear
to be running at the same time.

For specific information on Program Manager DDE, refer to the Microsoft Windows Win32 API 
documentation; "Shell Dynamic Data Exchange Interface".



Glossary of Terms
Administrative Privileges
Administrators
Client
DDE
Dragging
Dropping
FAT
HPFS
Icon 
Launch
NTFS
Object
Objects
Power Users
Program Manager
Registry
Server
Shareware
Shell



Administrative Privileges
Controlled by the Windows NT security system; indicates that the user is a member of the administrators 
group.



Administrators
Controlled by the Windows NT security system; members can fully administer the computer/domain. 
Members can also create, edit, and delete common desktops, and Program Manager common groups.



Client
In the context of drag and drop; a client program accepts one or more objects dropped on it from a drag 
and drop server program. The Windows Program Manager is a drag and drop client program. 



DDE
Dynamic Data Exchange. A method of exchanging data and executing commands between different 
application programs.



Dragging
Moving the mouse while holding down the left mouse button on one or more objects.



Dropping
Releasing the left mouse button while dragging one or more objects.



FAT
The file system used by MS-DOS. Also, the File Allocation Table. A table that contains the status of 
various segments of disk space used for file storage.



HPFS
High-Performance File System. File system that supports extended attributes and long, mixed-case 
filenames, and improves operating system performance by implementing several levels of caching. 
Windows NT does not recognize the extended attributes of a file created on HPFS.



Icon 
A small bitmap that graphically represents an object.    



Launch
The term launch refers to running, opening, or starting an application program.



NTFS
New Technology File System. File system that supports object-oriented applications by treating all files as
objects with user- and system-defined attributes. NTFS provides all the capabilities of FAT and HPFS 
without many of their limitations.



Object
In the context of Drag and Drop Desktop; an object is a program or document file that is represented by 
an icon and a title on the desktop window.



Objects
In the context of Drag and Drop Desktop; objects are program or document files that are represented by 
an icon and title on the desktop window.



Power Users
Controlled by the Windows NT security system; members can share directories and printers. Members 
can also create, edit, and delete common desktops, and Program Manager common groups.



Program Manager
The Program Manager is the shell program provided with Windows.



Registry
The database where configuration information is registered. This database takes the place of most 
configuration and initialization files for Windows and new applications.



Server
In the context of drag and drop; a server program allows the user to select one or more objects with the 
mouse and drag them on to a client program. The Windows File Manager is a drag and drop server 
program.



Shareware
A form of software distribution that allows the user to operate and evaluate software products before 
purchasing or licensing them.



Shell
The shell is a program that provides the primary user interface to Windows. Upon login, the shell is the 
only program running. All application programs are started by the shell program.




